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PROBLEM REPORTS AND/OR REACHING THE AUTHOR
If you have a problem with this software and want to file a trouble report, or if you simply want to send me 
a note, I can be reached at the following addresses:

SCOTT CRAIG - WA4TTK or Packet Mail to WA4TTK@KC4PRD.#midtn.tn
409 Jessie Drive or by phone at (615)333-1131 (NO collect calls)
Nashville, TN    37211-3534

My call is correct in any callbook after 1988.

Please include the version of the software that you are running (it is displayed at the top of the screen, 
and in the "ABOUT" selection of the help menu command), and as much information as you can about 
the problem you are having (the steps required to cause the problem, what happens, etc.) 

Be sure to include your return address.    This is a 1-man operation not a business, so time is limited, but I
WILL answer all letters received.    I am very interested in my software, and try very hard to write the best 
software that I can.    If you have problems, I want to know about it.    If you DON'T have problems, or have
ideas as to how the program could be made better, I want to know about that too.    I very much 
appreciate your thoughts and input, and would like to hear from you.

Thanks Very Much .... Scott



USING HELP

Using Windows Help files is frequently confusing and aggravating since they are frequently so convoluted
that you don't even know where you are any more!    Even though I tried to use some logic in the 
construction of this Help file, it is probably not an exception to the rule.    Most of the program is pretty self-
explanatory, so use this Help file to find information on the items you don't understand, or just want more 
information on.    Try not to get to upset, and don't call me too many names!

There are several methods to navigate through this Help file.    Generally, anytime you see a block of text 
in the help file that is highlighted, such as the word "Contents", you can move your mouse cursor onto it, 
and click the left mouse button to review the help pertaining to that section.    You can also click the "Back"
button at the top of the Help screen to "Backup" one section.    For example, if you click "Contents" and 
then "Options" from the Contents screen, you will see the "Options" help selection.    If you then click 
"BACK", you will "Backup" to the Contents screen again.    This way you can follow paths that interest you,
and "Backup" to where you started.    You can also get back to the very beginning of the help file by 
clicking the "Contents" button at the top of the help screen.

If you see a topic of interest, and would like to have a printout of the section, you can select "Print Topic" 
from the "File" pulldown menu at the top of the Help screen to print the current topic.

Windows also provides you with the ability to "Annotate" help files, or to add information that you want to 
add.    To add your own information, first select the section you want to annotate.    Then, from the EDIT 
menu selection on the Windows Help display, select ANNOTATE.    This will display a list box in which you
can type whatever text you want to be associate with the Help section.    When you are done entering your
annotation,    click "Save" to save the annotation.    Now, any time you select the "Annotated" section, you 
will see a paper clip icon displayed to the left of the section's title to denote that you have added 
something to it.    Click on the paper clip, and your annotation will be displayed.

The "Search" button at the top of the Help screen will display a dialog box that will allow you to "Search" 
for a desired topic.    Click "Search" to display the dialog, and then type a character.    For example, typing 
[O] will display all topics starting with "O".    If you then type a [P], all topics starting with "OP" will be 
displayed.    To go to one of the Help topics, select the topic in the lower list box with your mouse cursor, 
click the left mouse button, and then click "OK".

You can also get Help on most of the menu commands from within the program. Highlight the desired 
option by clicking on the menu item, and then press [F1] for help on that menu item.    Notice however that
some of the items are "Switches" and when you click them the menu will just be closed without giving you
the opportunity to press [F1].    What you may have to do in cases like this is to use your keyboard or 
mouse to select an option near the desired one, and then use the arrow keys to move to it without 
selecting it.

For example, the Options menu selection is used to select the optional program items.    If you wanted to 
see the help pertaining to "Grid Display On / Off" you would have to use this method.    If you just put the 
mouse cursor on "Grid Display On / Off" and clicked the left button, this would simply activate the option.   
What you need to do is to use the mouse (or keyboard) to select "Options", and then use the down arrow 
key on your keyboard to move the cursor bar down to "Grid Display On / Off".    When this selection is 
highlighted, then press [F1] to view the Help on this item.

Perhaps the easiest way for newcomers to the view the important aspects of the software is to use the 
"Guided Tour" option from the Contents display.    This will allow you to quickly review the most important 
features of the software by "Browsing" through it.    When Guided Tour is selected, the "Browse" buttons at
the top of the Help screen are active.    The Browse buttons are shown as [<<] and [>>].    Clicking the 
forward button ([>>]) will follow the browse sequence to the next topic.    Clicking the backward button 
([<<]) will go back to the previous topic.    If you see something of interest during the "Tour", you can 
branch to the item, and then use the [BACK] button to back up to the tour topic.





Command Line Options

SOL201W will accept the name of the data file to be used on the command line that starts the program.    
You set up the command line from Program Manager.    From the FILE command option of program 
manager (NOT File Manager!), select the PROPERTIES command, and the following dialog box will be 
displayed.

The second line is the command that starts the program, and how the command line currently reads on 
your system depends on what directory you installed the software in.    Assuming that you installed it in the
C:\HAM directory, the command line would read C:\HAM\SOL201W.EXE.    To specify a file to be loaded 
when the program starts, move to the end of this line, and enter the directory and file name of the data file
to be used.    For example, to start the program running using C:\TEMP\DATA\GRAPH.DAT as the data 
file, the command line would read C:\HAM\SOL201W.EXE C:\TEMP\DATA\GRAPH.DAT.

NOTE: If you have enabled Save Last File Name in the options menu, passing the name of the data file 
on the command line, as described here, will override the file name stored in the configuration 
file.



Using the Mouse

Using the mouse in Version 2.01 is slightly different than it was for previous versions.    You can still use 
the left and right mouse buttons to Pan the close-up frame left and right, but the AutoTrack feature that 
was used in Version 1.x has been eliminated.    I felt it was actually redundant, so I just left it out.    If 
anyone wants it back, let me know!

Here is how the mouse buttons are used in Version 2.01:

When the mouse cursor is in the OVERALL SCREEN, clicking the LEFT mouse button will center the day 
closest to the mouse cursor in the center of the close-up screen.    If the selected date is too close to the 
beginning or end of the data file, it may be shifted somewhat so that the data file ends are not exceeded.

When the mouse cursor is in the CLOSE-UP SCREEN, clicking the LEFT mouse button will pan the 
close-up screen left (toward the beginning of the data file) by a number of days set by the PanDays value.
Likewise, clicking the RIGHT mouse button will pan the close-up screen right (toward the end of the data 
file) by a number of days set by the PanDays value.

There is also a Scroll Bar at the bottom of the window.    This scroll bar can be used as a visual reference 
as to where the closeup frame is within the data file, and also to scroll the closeup screen.



PLEASE READ THIS ...

This is a completely optional item, and whether you respond to it is entirely up to you.    As I stated earlier, 
this software is free with NO STRINGS ATTACHED.    I don't want anything for this software.    I get my 
kicks out of writing software and seeing people use it.    I get paid for writing software at work, so this 
program is purely just for the fun of it.

If you like this software, and feel so inclined, send a donation to your local Humane Society or Animal 
Shelter.    A dollar or two here and there can frequently make a big difference.    It may be enough to keep 
a dog or cat alive for one more day, perhaps the day that someone will come to adopt them.    The Animal 
Shelters do a great job most of the time, but they cant be expected to keep animals indefinitely until 
someone wants them.    They live by the same rules that we do, where the Almighty Dollar is in command. 
If a few of us send them a little bit, maybe it will do some good.

I love animals, and they are frequently more at the mercy of our society than any people are.    If a person 
doesnt like his position, he is free to do something about it.    Jobs can be found, professions are a little 
harder, but jobs CAN be found.    The domesticated animals don't have that luxury.    They are subject to 
our rules, and in many cases our rules don't fit them that well.    When they are hungry and homeless, 
they get locked up for a few days, but if no one comes for them, their time is up.

Again, this is completely optional.    It is not a plea for money or donations, or anything like that.    If you 
don't want to, please don't feel obligated.    It is certainly not one of the conditions of using this software, I 
just thought it would be a nice idea.    If you don't want go give them anything, that is OK, just accept my 
thanks for taking the time to read this!



Printing Your Data

This command is used to make prints of the data.    You must have a Windows compatible graphics printer
attached and properly configured to use this option.

When the command is selected, the Windows standard Print common dialog box is displayed as shown 
below.

Here you can select options pertaining to the print job, however as far as the job itself goes, there is really
nothing to change!    There will only be one page to print, so you cant change that.    You can click the 
Setup button to access the printer setup dialog box that will allow you to change parameters specific to 
your printer.    A sample is shown below.

Once you have everything configured properly, click OK to begin the print process.    A dialog box will be 
displayed while the print job is being generated.    If you change your mind about the print, click Cancel to 
cancel the printing process.    Otherwise, once the print file has been generated, it will be sent to the 
designated printer.

A few notes about the print process .....

First, this is my first attempt at printing information in Windows.    I did my best to accommodate the 
Windows printing system, but I don't promise that everything will work properly with every printer.    I have 
tested this on the printers that I have access to, and everything seems to work great.    Unfortunately, I 



don't have access to a great number of printers.    Therefore, if you have problems printing, PLEASE let 
me know.    I would greatly appreciate your sending me a copy of what it looks like, along with a note 
letting me know the specifics of your printer.

Next, a bit about what the prints look like.    Basically, it looks the same as it does on your screen 
(depending on the items you have turned on in the Display and Print Options selection).    At the top of the
printout is the name of the data file, and the date and time of the printout.    Below this, ¼ of the screen is 
devoted to the overall frame, with the beginning and ending dates, and the number of days in the data file 
displayed beneath.    Then comes the close-up screen.    Again, the beginning and ending dates and the 
number of days on the plot are displayed.    Finally, toward the bottom of the print, the record high and low
values from the data file are displayed.

The types of data (Solar Flux, Sun Spots or the averages) that are included on the print are selected from 
the Display and Print Options selection on the Options menu.    Just like on the display, you can select 
among Solar Flux, Sun Spots, and the averages.

High-resolution printers such as lasers and ink jets generate very high-resolution prints.    In fact, the 
overall plot may have so many fine lines that it is difficult to see what is what, so you may want to print 
only the solar flux or sun spots.    This is done through the configuration options, because, basically What 
you see is what you get!    If you have an option turned on so that it is displayed on the screen, the same 
option is used for the print procedure.    Filled plots, grid lines, colors, they all affect the output of your 
print.    The more options that you have turned on, the more data will be displayed on your print.

Unless you have a color-capable printer, you will probably want to turn Filled Plots OFF on the Display 
and Print Options dialog before you print your file.    Having a bunch of solid black plots on top of other 
solid black plots doesnt show very much!

If you have a color-capable printer, you have the choice of turning Color Printing on or off on the Display 
and Print Options dialog.    When this switch is On, prints will be generated using the screen colors for the 
print colors.    If this switch is Off, prints will be generated using only a black pen.    Regardless of this 
setting, the border and text of the print is always generated in black.



PRINT - SCREEN PREVIEW

This command actually Prints your data, but it prints it to your screen instead of the printer.    You can use 
it to Preview a printout before you actually send it to the printer.    What you see on this preview screen is 
what you will see on the printout.    If Color Printing is enabled on the Display and Print Options dialog, the
plots will be in color.    If Filled Plots on the Display and Print Options dialog is enabled for printing, the 
plots will be filled (in black if Color Printing is NOT enabled).

The screen has a number of controls at the top so that you can zoom in or out, print the screen, etc.



A Guided Tour

Use the BROWSE buttons at the top of the Help display to go through this tour.    Clicking the Forward 
Button (>>) will move you to the next section.    Clicking the Back Button (<<) will move you to the 
previous section.    You can still branch to any section you are interested by Clicking on any of the 
highlighted Jump areas, or move back to the start of the Help file by clicking the Contents Button.



Introduction to SOL201W

First and for the record, I don't claim to be an expert on solar activity; in fact I don't even claim to know 
anything about it!    That was why I initially started this program.    I really enjoy reading Tad Cook's 
PROPAGATION FORECAST BULLETIN each week (transmitted on W1AW and available on many 
Packet BBS's) but I needed some way to put his sunspot and solar flux values into a format I could relate 
to my on-the-air experience.    This program lets me do that by plotting the sunspot and solar flux values 
from the PROPAGATION FORECAST BULLETINS in a graphic format.    I can look at the plot and look at 
my logbooks and see why the band was dead on a    particular day, or why propagation was so good on a 
particular day.

This is the second version for Windows.    The program was originally written for native DOS, and has 
been rewritten for Windows to take advantage of many of the capabilities of the Windows environment.

It is not a real fancy program.    It does not do MUF plots or anything like that.    It is just a utility that puts 
things into perspective for you, and makes the solar information easier to visualize.    The data is 
displayed graphically in two windows as shown below:

One frame is an overall frame in the top portion of the window showing all of the data from day one to day
"x" (depending on the size of the data file).    The second is a close-up frame on the lower portion of the 
window.    When the data file gets quite large the entries get so close together that it is difficult to see 
anything in the "Overall" frame, yet when you are viewing just a portion of the data it is difficult to get the 
"Big Picture".      Therefore, you have two frames. The overall is generally used for getting an overall view 
of the data and the close-up is used for looking at more precise information.    The close-up may be 
Scrolled left or right    through the data file month-by-month by using the left and right Mouse buttons, or 
the ScrollBar at the bottom of the window.    If the Mouse's cursor is in the upper Overall Frame, clicking 
the left mouse button will center the day that is closest to the cursor in the closeup frame.    If the mouse's 
cursor is not in the overall frame, pressing the left button will scroll the closeup frame toward the top of the
file, or pressing the right button will scroll toward the end of the file.

A Grid may be displayed in each of the frames, denoting, by default,    WEEKS and MONTHS.    The 
weeks are drawn in dotted lines and the months are in solid lines.    The "Months" start at the beginning of 



the file.    Every 28 days, a new "Month" is started (28 days was used since the Earth rotates around the 
Sun every 28.5 days).    On the overall window, the "Week" lines have been omitted since they are 
normally too close together to see.    The grid may be turned on or off, and the resolution of the divisions 
may be set through selections on the Options menu.

There are several options that you can set to control how much information is displayed in each frame at 
one type.    You can change the colors, which sections are on (Sun Spots, Solar Flux, Average Values and
the Grid), and how many days are shown on the close-up frame.    Each of the options is documented in 
the Options Menu help selection.

You can also use this program to Edit the data in the data file, and to Print portions of the data file in a 
graphic format, similar to what you see on the screen.



Error Messages

There are several areas in the program where errors may occur.    The following table lists the possible 
error messages, and their possible solutions.

Could Not Open Data File
Not A Solar Data Plot File
Incorrect File
Could Not Allocate Memory
List Box Would Not Hold Entire Data File
Select Record In List Box First
CTL3DV2 Not Found in Windows System Directory



Error - CTL3DV2 Not Found in Windows System Directory

This program, like most of the current Windows applications supports the use of 3D Appearing controls 
and dialogs.    The method by which all Windows applications accomplish this is through the use of the 
Microsoft CTL3DV2.DLL file.    This file contains all of the function calls to draw 3D Appearing controls and
dialogs.

Due to Microsofts attempt to Standardize Windows application development, this file MUST reside in the 
Windows System directory, unlike the earlier CTL3D.DLL which could reside in any directory that is 
included in your Path statement.

If you want to use the 3D Appearance option, CTL3DV2.DLL MUST be in the Windows System directory.   
NO OTHER!    If, when the program starts, this file is not found in the proper location, you will receive this 
message.    The program will continue to run, but you will not be able to use the 3D controls.



Error - Select Record In List Box First

You got this error trying to INSERT or DELETE records in the data file, using the EDIT mode.    Before you
can INSERT or DELETE records, you must tell the system WHERE in the data file to insert or delete.    Do
this by Clicking on the record in the list box that is JUST BEFORE where you want to insert or delete 
records.



Error - List Box Would Not Hold Entire Data File

This error will occur when you try to Edit a very large file, or when you try to insert records into the listbox. 
If it occurs when you try to insert records, the error dialog will be slightly different than that shown above.   
Instead of showing the number of records read, it will show the number of records successfully inserted.    
Windows has a limit on the amount of data that can be inserted into a Listbox.    If you try to edit a file that 
exceeds this limit, Windows will not load all of it, and you will receive this message.    This problem 
honestly is not my fault.    It is a limitation in Windows!

There are only 2 solutions to this problem, and neither of them are very good.    First, you can reduce the 
size of the file.    When the error occurs, the MessageBox tells you how many entries were actually 
loaded.    If you delete enough entries from your file (yes, I know you don't want to delete entries, but I told
you neither solution was very good!), you will be able to edit the remainder.

The second solution is to exit this program and edit the data file using another editor.    Notepad probably 
wont load it either, so you may have to use the DOS editor or another Windows editor that you have that 
will accept large files.



Error - Could Not Allocate Memory

This error will occur when SOL201W tries to allocate memory prior to loading a data file from disk.    If 
your system does not have much memory, or if you have a lot of Windows applications open, there may 
not be enough memory left to load the specified data file.    You can see how much of your system 
memory is available using the About selection on the Help command selection.

There are several ways to solve the problem.    Of course, one is to add more memory to your system, but
I will not insult you with that one!    If you have several Windows applications open, close some of them 
before you run SOL201W.    You can see what applications are open by pressing [CTRL][ESC].    This will 
display a listing of open applications.    Switch to one or more of the applications, and end them normally, 
then try running SOL201W again.

If you still have problems, check the size of the data file you are trying to open.    You can do this from File 
Manager or from DOS using the DIR command.    When SOL201W loads a data file, it allocates a block of
memory about 1.5 times the size of the file because it has to store the data in the file, plus the values for 
the averages.    Additionally, it allocates a little free space so that as you add entries, it doesnt have to 
reallocate the memory every time.    If you have a lot of comment lines in the data file, these could be 
taking up enough memory to prevent you from loading the file.    Remove comments (BUT DON'T TAKE 
OUT THE FIRST LINE!), and that may free up enough space for the file to load properly.

Finally, if you still cant get the file to load, you may have to split the file into more than one file.    You can 
do this with any normal text editor, but be sure to add the HEADER LINE to the beginning of the file!



Error - Could Not Open File

This error will occur when the program first starts. By default, the program looks for GRAPH.DAT as the 
data file, and it expects it to be in the same directory as the program file SOL201W.EXE.    If it does not 
find the data file when it starts, this error message will be displayed.

This is not a Fatal error, and will not stop the program from running.    All it does is prevent the data file 
from being read.    The display will be generated, but no data will be plotted.

There are 4 ways to fix this problem.    First, you can move the data file GRAPH.DAT from wherever it 
currently is located on disk to the same directory as the program file.

If you don't want to do this, you can change the working directory for SOL201W to point to another 
directory.    To do this,    open the PROPERTIES dialog from the FILE selection of Program Manager 
(Program Manager is the default desktop for Windows.    If you are using another desktop such as the 
Norton Desktop, the procedure may be slightly different).    This dialog shows the command associated 
with a program.    The command line is the command that is executed to start the program.    This should 
include the directory to start SOL201W.    The next line is the working directory.    By default, it is the same 
directory as established for the program.    If you want SOL201W to look in a different directory for 
GRAPH.DAT, enter the name of the directory on this line.    The next time you run SOL201W, it will look in 
the specified directory, and should find the data file correctly.

The third way to solve the problem is to specify the directory where your data file is located on the 
command line that starts the program.      See the Command Line help section for further information on 
this option.

Finally, you can open the desired file with the FILE/OPEN command, and enable the Save Last Open File
Name function on the configuration menu.    This will cause SOL201W to open the last file you had open 
in the PREVIOUS session when it starts a new session.



Error - Not A Solar Data Plot File

This error will occur when you have try to open a file that is not a data file for SOL201W (if the file worked 
fine in version 1.x, READ ON!).

This is not a Fatal error, and will not stop the program from running.    All it does is prevent the data file 
from being read.    The display will be generated, but no data will be plotted.

Beginning with this version, I included a check to insure that the data file is indeed a proper GRAPH data 
file.    If you have upgraded this software from a previous version, and are using your old data file, all you 
need to do is add one line to the data file, and it will fix this problem.

The FIRST line in the Version 2 data file MUST read ! WA4TTK Solar Data Plot Version 2 Data File 
(without the    characters).    A Message Box will be displayed stating that "If This Is A Version 1.x Data File
This Function Can Update It To Version 2".    If AND ONLY IF you are CERTAIN that the file you tried to 
open is a Version 1.x data file, let the function go ahead and fix it.    All it will do is insert one line at the 
top.    If it is NOT a version 1.x data file, the file (whatever it happens to be) WILL PROBABLY BE 
RUINED.    This function will stick the header line in the file, and if it happens to be a file belonging to 
something else, it will probably ruin it!    If you aren't sure, make sure first!

If this is not a data file from a previous version, then you have tried to open a file that is not a SOL201W 
data file.    Select the proper file, and everything should work fine.



New For Version 2

As background for those of you who are new to this program, it started about 2 years ago.    The initial 
version was a DOS-based program that plotted solar information from Tad Cooks Propagation Forecast 
Bulletin in a graphic format.    Last year, I wrote the initial Windows version, and released a greatly 
enhanced version of the DOS program.    The Windows version took advantage of many of the features of
the Windows environment to enhance the usability of the software.

Version 2 of this program is a complete rewrite!    Less than 1% of the code used in Version 1.x was 
reused.    Version 1.x for Windows was written in Borland Turbo C++ Version 3.1. This version is written in 
Microsoft Visual C++, and as well as introducing several new features, is much prettier, and faster.    All of 
the features of Version 1.x are still there, but several new features have been added.

The new features of Version 2 are:

Much better HELP file.    This help file contains much more information than the Version 1.x help file 
(and consequently, it is bigger!)    It also has Context Sensitive help and Search enabled.    You can 
Search for a topic by clicking on the Search button on top of the Help dialog, or from within the 
program, you can select a menu command and press [F1] for help on that command.

Enhanced display.    Much more attractive than earlier versions.    The main display and all dialog 
boxes use the Windows 3D controls for a much improved display.    Optionally, you can turn the 3D-
look off and use a normal Windows display.

Adjustable Frame Percentages.    By default, the Closeup and Overall frames are the same size.    If 
you want one to be larger than the other, you can set the percentage by selecting Overall Frame 
Percentage from the Options Menu.

User-selectable Display and Print Items.    There are four types of data that may be displayed, Solar 
Flux, Sun Spots, Average Solar Flux, and Average Sun Spots.    You may selectively enable any or 
all of these items for either the Overall or Closeup Frames by selecting the Display and Print Options
option from the Options Menu.

Better Keyboard Control for Non-mouse Users.    The previous version did not have very much 
control for those of you who don't use a mouse, or just don't like them.    I know I find myself using 
the keyboard a lot, so this feature should benefit a lot of you.

A ScrollBar on the main display aids in visualizing where you are in the data file, and also in 
positioning the closeup frame.

Added Data File Editor.    Now you can edit the data file or add entries from within the program.    Be 
sure and read the help section on Editing before you use it!

Faster.    Most features of this version are much faster than the version 1.x program.

A Filled Plot Option on the Display and Print Options allows you to use the normal Skeleton plots or 
Filled plots.

A Stagger Plot option allows you to plot the data file in a "Staggered" format, or in other words, just 
display every "Nth" day in the file.

Proper Window Sizing.    In the previous version, when the Window was resized, the data plots were 
not resized properly causing part of the data display to be lost.    This has been fixed (actually, I didnt 
even know the old version did this until I started working on this version!)

Print Option.    Now you can print the data to a Windows-compatible printer in graphic format.    You 



can also Preview the data on the screen before you send it to the printer.

User-selectable Grid Resolution.    Now you can set the grid resolution for both the overall and close-
up frames to    weeks, months, or years.

Better error control.    There are many more Error traps than in previous versions.

The Last Open File can be saved so that it is reloaded when the program is started the next time.

Command Line Passing.    The command line is now passed to the program so that you can specify 
the name of a desired data file on the command line.    For example: SOL201W JUNK.DAT will start 
the program and use JUNK.DAT (in the same directory as SOL201W) as the default data file.

Optional Record Markers can be enabled on the Display and Print Options dialog to show you where
on the plots the Record days occurred.

The Position of the program's window on the screen can be saved so that the next time you run the 
program, the window will be the same size, and in the same place on the screen.

Generally speaking, if you liked the previous versions, you will love this one.    It is a lot better, and I am 
actually quite proud of it this time!

As with all the previous releases, this one is free for the asking.    If you like it and want to give it to a 
friend, please feel free.    It is FreeWare, and there are no strings attached.    All I ask is that you adhere to 
the distribution policy spelled out in the Copyright Information section.

GL es 73s de Scott - WA4TTK



File menu commands

The File menu offers the following commands:

Open Opens an existing document.
Save Saves an opened document using the same file name.
Save As Saves an opened document to a specified file name.
Exit Exits the Program.

AVERAGING INFORMATION

Tad Cook (KT7H) has been a great help in getting me straightened out on how averages should be done. 
The averaging in this program uses a moving-window average where each day on the average line 
represents a value that is the average of a number of days before and after the current day.

If a cumulative average had been used (as I originally did!), you would never see any trends.    The 
average for a particular day would simply be the total of all the values up to that day, divided by the 
number of days.    Trends would disappear quickly as the number of days increased.

Using a "Moving Window" the trends are easily seen since the average for any particular day is based on 
only a small portion of the data file.    The average for the current day is calculated by adding the values 
for a certain number of days before and including the desired day and a certain number of days after, then
dividing by the number of days in the period.    This means that the "Window" from which the average is 
calculated "Moves" as the days progress through the data file.    The number of days in the averaging 
period may be defined using the OPTIONS|AVERAGE DAYS command from the menu bar.

Some people will argue that a window averages that uses days AFTER the desired day are invalid since 
they use data that has not happened yet.    They will want only a particular number of days BEFORE the 
desired day and NONE after.    Others will want more or less days before, and more or less after.    
Therefore, both the AVERAGING PERIOD and the LAG days may be changed if desired.    The OPTIONS
selection on the menu bar shows AVERAGING PERIOD and LAG DAYS.    Using these two values you 
can set the averaging to however you want to see it.

If the AVERAGING PERIOD is set to 28 and the LAG DAYS set to 0 then the 27 of the 28 days in the 
period will precede the desired date.    If the AVERAGING PERIOD is set to 28 and the LAG DAYS set to 
13 (the defaults) the program will calculate the average for each day based on the previous 14 days, the 
current day, and 13 days following the current day.

Now, since the averaging period has a certain number of LAG and LEAD days, the first part of the file and
the last part of the file will not have an average since part of the data required to calculate the averages is
not there.    If you need the previous 14 days to calculate an average, the first day in the file does not have
14 days previous.    Likewise, if you need 14 days past the current day to calculate the average the last 
day in the file does not have them.    So what do you do about it?    One recommendation is to just not 
display this data since anything there would not be a correct average.    Personally, I prefer to see a 
cumulative average up to the point where the moving average can take over.    The choice is yours.    If 
you want to see the cumulative average, it is there, displayed in WHITE instead of the normal color.    If 
you don't want to see the cumulative averages, they can be turned off with the CUMULATIVE AVERAGES
option of the OPTIONS selection of the main menu.



DATA FILE STRUCTURE

The data that is displayed graphically is stored in a data file on disk.    By default this file is named 
GRAPH.DAT but you can name the file anything that you want to.    You may want to have a file for each 
year, such as GRAPH.92 or PFB.93 or whatever you decide.    When the program is started from 
Windows, it will attempt to read GRAPH.DAT.    If it cant find it no file will be loaded, however you can load
a different file by selection the OPEN command from the FILES section of the main menu. (Alternatively, 
you can set the program so that the desired file name is passed on the command line, or enable the Save
Last File Name option for the configuration file.)

The structure of the data file was kept very simple so that it would not be difficult to add data to it each 
week.    It is just an ASCII file that may be edited with any text editor (or the Windows NOTEPAD), or the 
EDIT command on the main menu.    Don't use a word processor unless you can do so in ASCII mode 
since most word processing software puts special control characters in the file that would not be 
understood by this software.

The data file contains three columns of data, all three of which are taken from Tad Cook's Propagation 
Forecast Bulletin.    The first is the date, second is the sunspot value, and third is the 10.7cm Solar Flux 
value.
Here are some examples:

04/19/91 152 229.0
04/20/91 122 201.0
04/21/91 92 180.0
04/22/91 73 166.0
05/20/93 48 91.1
05/21/93 34 91.0

Notice that the values are right-justified with the columns, or when the sunspot or solar flux values are 
less than 100, the right-most characters line up.    The date starts in column 1.    The sunspot value starts 
in column 13, and the solar flux value in column 19. If you use the supplied data file as an example, you 
will not have any trouble.

Comments may be added in the data file as desired by beginning the line with an exclamation point ("!").   
Any line that begins with this character is assumed to be a comment line when the data file is read, and it 
is ignored.

NOTE:    Beginning with this version, I included a check to insure that the data file is indeed a proper 
GRAPH data file.    The first line in the data file is ! WA4TTK Solar Data Plot Version 2 Data File.    DON'T 
CHANGE THIS LINE OR MOVE IT FROM THE TOP OF THE FILE!    If it doesnt read EXACTLY as 
shown, you will get an error message stating that the file you are trying to load is not a solar graphing 
data file.    See the Not A Solar Data Plot File error message for more information.

Sun spot data BEFORE the date April 18, 1991 uses a calculated value.    The data was compiled by Syd 
Horne - VE3EGO from WWV transmissions, but before this date, WWV did not transmit the sun spot 
numbers, only the 10.7cm solar flux value for the day.    The ARRL ANTENNA BOOK (16th edition) 
contains a formula for approximately calculating the sun spot value for a particular day based on the solar
flux value.    The formula is:

S = 33.52 * SQRT(85.12 + F) - 408.99

where "S" is the sun spot value, and "F" is the solar flux value.    SQRT is "Computerese" for Square Root.

When you look at the display, you will note that for this part of the file, the solar flux and sun spots have 
the same relationship to each other.    This is to be expected since the formula is a relational formula.    If 



you don't want this information, edit the data file and set all of the sun spot values to zero.    Then they will 
plot as a straight line at the bottom of the display.



CREDITS

While I did all of the programming, I certainly cant take all the credit for the program.    Tad Cook - KT7H 
has been an enormous help, answering numerous questions pertaining to the solar data, and averaging.   
He also provided many people with copies of the original DOS version of this program by posting it on the
ARRL bulletin board.

Syd Horne - VE3EGO has also been a great help.    He compiled the solar flux data for 1989 through 
1991.    The data I got from Tad Cook only went back to 1991, and Syd's addition has made very 
interesting "Reading"!

Joel Masur - AA5YA generated the documentation for the DOS version of the program.    To him also goes
a great vote of thanks.

If you have problems or comments about the program, I would love to hear from you.    My address is in 
the Help section pertaining to Problem Reports

73's ... Scott Craig ... WA4TTK



COPYRIGHT INFORMATION and DISCLAIMER

This software is owned and copyrighted by the author, however it is released for NON-COMMERCIAL 
and NON-PECUNIARY distribution as long as ALL portions of the software are distributed in an unaltered 
format (with the exception of the data file GRAPH.DAT), and all sections of the program (executable 
image, help files, installation files, etc.) are distributed together.    It is not shareware, it is free.    If you 
know of someone who would like a copy, please feel free to GIVE him a copy.    YOU MAY NOT CHARGE
ANY AMOUNT FOR THE DISTRIBUTION.    As I said, this software is FREE.

Amateur Radio is a fascinating hobby, and one of the rules by which we live is "The amateur's proven 
ability to further the state of the radio art, and to enhance international good will".    There are many Hams 
who have the ability to write software, and many more who would love to have the software yet don't have
the ability to write it.    How about a few more of you guys pitching in!    Believe me, I got a lot out of this 
project besides money!

DISCLAIMER

This software is provided on an as-is basis.    Neither the author nor any distributor of this software offer 
any    warranty of any kind, nor accept responsibility for any    damages of any type incurred through or by 
the use of this software.

This software and all associated files are:

COPYRIGHT, 1995, SCOTT CRAIG
ALL RIGHTS RESERVED



RECORDS MENU SELECTION

When this menu command is selected, the dialog box shown above will be displayed showing the highest 
and lowest sun spot and solar flux values that were located in the data file.    This information is located 
each time you open a file, and also each time you edit the existing data so that it will remain current.



OPTIONS MENU SELECTION

The options menu for Version 2.01 contains many more options than on the Version 1.x program.    You 
have much more control over what is displayed on your screen and on the printouts.    The menu is 
divided into two sections as shown below:

The top section of the menu will activate sub menus or dialog boxes that allow you to select additional 
options.    The lower section is a group of "Switches".    They are called switches because they can either 
be on or off.    When one of the switches is On, a checkmark will be displayed beside the option.    When a
switch is off, no checkmark will be displayed.

Colors Sets the displayed colors of various elements of the display
Averaging Interval Sets the interval used by the averaging calculations
Lag Days Sets the number of Lag Days used by the averaging calcs.
Close-up Days Sets the number of days on the close-up display
Pan Days Sets the number of Pan Days
Overall Frame Percentage Sets the percentage of the view used by the Overall frame.
Grid Resolution Options Sets the resolution of the grid for each frame
Configuration File Options Configuration File Options
Display and Print Options Selects the types of data that will be displayed and printed.
------------------------------------------ ----------------------------------------------------------------------------------
Stagger Plot ON/OFF Turns "Stagger Plotting" On or Off
Position Data ON/OFF Turns the mouse cursor position display On or Off
3D Appearance On / Off Turns 3D-appearing controls On or Off

Each of the options has one character underlined.    In addition to selection the option with the mouse, you
may also select it by pressing the key that corresponds to the underlined character.



STAGGER PLOTTING

This option may take a little explaining.    The way it works is that, when Stagger Plotting is enabled, only 
every "Nth" day is read from the data file.    The effect is that you can see what the solar activity looked 
like in specific intervals.    One way to use this feature is to view the data on days when the same part of 
the sun was facing the earth.    The sun has a rotational period of 27.5 days.    If you set the interval to 28 
days, you will see what the data looks like every time the same portion of the sun was facing us.

The data frequently looks strange on the screen.    If you look at the Sun Spots or Solar Flux values, the 
data is similar to what you always see.    But, if you turn off the Solar Flux and Sun Spot displays, and turn
on the Average Solar Flux and Average Sun Spot displays (using the Display and Print Options selection) 
you will normally see a smooth progression of data.    It is actually somewhat depressing to see it drop like
that, but it will get better!

When the option is selected, the dialog box shown above will be displayed.    The first edit field is for the 
number of days in the period.    If you want to see every 28th day, enter 28 here.    If you want to see every
7th day, enter 7 here.

The next edit field determines what day in the data file is to be used to base the periods on.    This does 
NOT have to be the first occurrance in the data file.    For example, if you want to see a 28-day plot, and 
want August 23, 1991 to be included in the plot, just enter 08/23/91 in this field.    The program will "Back 
Up" toward the beginning of the file, and find the first date in the file that will put the specified day on a 
multiple of the period, so that it will be displayed.

This date must be entered in the format DD/MM/YY, or if you have reversed the dates in the data file to 
match European standards, MM/DD/YY.    Whatever format you have in the data file, this date must be 
entered the same way, because the program does a straight comparison of the date you enter with the 
information in the data file.    If the date is not found, a message will be displayed informing you of this, 
and Stagger Plot will then be disabled.

The final item on the dialog is a checkbox.    When this checkbox is "Checked" (it has an "X" in it), Stagger
Plots are enabled.    When it is not checked, Stagger Plots are disabled.    Additionally, when Stagger Plots
are enabled, a check mark will be displayed on the options menu beside the Stagger Plot option.

The way this option works is that it actually rereads the current data file, and as it reads the file, it simply 
skips groups of days.    If you open the Data Editor, you will notice that the only days that show up are, as 
usual, the ones that are displayed.    Because of this, if you want to save the Staggered data in a file, all 
you have to do is save it with the Save As command on the File menu.    Be sure to use the Save As 
command, and give the new file a different file name or you will overwrite your current data file with the 
staggered data!



OVERALL FRAME PERCENTAGE

This option allow you to set the percentage of your window that is used by the Overall Frame.    By 
default, both the Closeup and Overall frames are the same size.    If you would rather have one larger 
than the other, you can set the percentage value here.

The number you enter must be between 10 and 90 (for 10% through 90%), and it denotes how much of 
the window area is given to the Overall frame.    The Closeup frame will get whatever is left.    For 
example, if you enter 50, the two frames will be the same size.    If you enter 40, the overall frame will get 
40% of the available area, and the closeup frame will get 60%.    If you enter 30, the overall frame will get 
30% and the closeup frame will get 70%, and so forth.



PAN DAYS

The PAN DAYS option sets the number of days left or right that the close-up frame is Panned when the 
left or right mouse button is clicked.    By default, it is set to 252.    This is the same value as the number of
days on the close-up frame by default, so that when you Pan, the screen is panned by the same amount.



CONFIGURATION FILE OPTIONS

The CONFIGURATION FILE is a file that contains all of the configuration values of the program.    The 
configuration file used by this program is a Private configuration file, and as such is located in the same 
directory as the program files (I have a REAL problem with programmers that stick Private configuration 
files in the Non-Private Windows directory!).    It is named WA4TTK.INI, and although it is just a text file, I 
don't recommend that you edit it manually unless you are familiar with working in configuration files.    This
configuration file is common to all of my Ham related programs, and the section pertaining to SOL201W is
called SOLAR_DATA.    There is nothing in this file that you cant change from the OPTIONS menu, so 
there is really no need to edit it manually.

If you do edit the configuration file and get it messed up, or if you just want to reset the program defaults, 
just use File Manager to delete the configuration file, and the next time you start the program, the defaults
will be used.

The Options menu has four selections pertaining to the configuration file.    They are:

AutoSave Config On / Off Automatically saves the configuration when the program ends
Load Config Reloads the configuration file from disk
Save Config Saves the current configuration file
Save Last Open File Name Saves the name of the last open file and loads it when the program

starts
Save Window Position Saves the current windows position on the screen



SAVE WINDOW POSITION ON / OFF

When this option is enabled (denoted by a checkmark beside the menu option), the current position of the
programs window on the screen is saved in the configuration file.    The next time you run SOL201W, the 
window for the program will be in the same place on your screen.



SAVE LAST OPEN FILE ON / OFF

When this option is enabled (denoted by a checkmark beside the menu item), the name of the last data 
file you have open is saved to the configuration file (assuming that you have AutoSave Configuration 
turned on, or manually Save the configuration file).    The next time you run SOL201W, this file will be 
automatically opened instead of the default GRAPH.DAT file.

This option is handy if you normally like to use a different file, or if your GRAPH.DAT file is in a different 
directory from the program file.

Note: If you have this option enabled, and then delete or move the file that you last had opened, when 
you start SOL201W the next time, you will get a File Not Found error message.    This is no real 
problem, just use the FILE/OPEN command to open the desired file, and be sure to save the 
configuration file again (either automatically or manually) and it will reflect the new file name.

Note: If you have the program set up so that it passes the file name on the command line, the command 
line file name overrides this option.    Something had to have priority, so I decided to let the 
command line have it!



AUTOSAVE CONFIGURATION ON / OFF

This switch determines whether the program automatically saves the configuration file when it ends.    If 
this switch is turned ON (denoted by a checkmark beside the menu selection) then the configuration 
values in effect when the program ends will be written to the configuration file, and will be used the next 
time the program is started.    If this switch is OFF (no checkmark beside the menu selection), the 
configuration values will NOT be automatically saved when the program ends.    You may save the 
program configuration manually at any time by selecting the Save Configuration option from the 
configuration menu.    You may also load the configuration file from disk manually at any time by selecting 
the Load Configuration option.



LOAD CONFIGURATION FILE

Selecting this option from the OPTIONS/CONFIGURATION file menu reloads the configuration from disk 
right then.    If you change a bunch of options and don't like them, you can reload the values that were in 
effect when you started the program by selecting this option.



SAVE CONFIGURATION FILE NOW

Selecting this option from the OPTIONS/CONFIGURATION FILE menu writes a new copy of the 
configuration file to disk right then.    Any options that are in effect at the time that the configuration file is 
written will be loaded the next time the program is started.



3D CONTROLS ON / OFF

Most people like the 3D-appearing controls of most later Windows applications.    If you are one of the 
Purists that prefers the original style of windows, you can turn the 3D appearance on or off with this 
switch.

When the 3D appearance is ON, a checkmark will be displayed beside the option on the menu.    When it 
is OFF, there will not be a checkmark displayed.



GRID RESOLUTION OPTIONS

This option sets the resolution of the grid for both the overall and close-up frames.    When it selected, a 
dialog box will be displayed with 6 Radio Buttons set into 2 groups.    One group is labeled Overall Grid, 
and the other is labeled Close-up Grid.    You select the desired resolution by clicking ONE of the buttons 
for each group.    The buttons are interlocked so that you can only select one for each grid (hence the 
name Radio Buttons since like a car radio, you can only select one button at a time).

The options for each grid are:

WEEKS - 7 days
MONTHS - 28 days
YEARS - 365 days

Using the WEEKS option on the overall grid will probably place the lines too close together for you to see 
very much if the file is very big.    Likewise, setting the close-up grid to years will not show very much, but 
you are free to choose them if that is what you want!

When the Close-up grid is set to weeks, you will see two line styles.    One is dotted, and the other is solid.
The solid lines denote monthly (4-week) divisions, and they correspond to monthly divisions in the overall 
grid.



DISPLAY AND PRINT OPTIONS

There are four types of data that may be displayed, Solar Flux, Average Solar Flux, Sun Spots, and 
Average Sun Spots.    In addition, there are two display frames, the upper Overall Frame and the 
lower Closeup Frame.    This option allows you to selectively choose what data will be displayed in 
each frame.

There are 6 "Blocks" of options as can be seen above.    The upper left block controls the settings for the 
OVERALL VIEW on the DISPLAY.    The upper right block controls the settings for the OVERALL 
VIEW on the PRINTOUT.    The next row of "Blocks" control the settings for the closeup view on the 
display and printout.    Each "Block" has 8 Check Boxes to set options pertaining to that section of the 
display or printout.    The checkboxes are:

* Solar Flux ON / OFF
* Filled Solar Flux ON / OFF
* Average Solar Flux ON / OFF
* Filled Average Solar Flux ON / OFF
* Sun Spots ON / OFF
* Filled Sun Spots ON / OFF
* Average Sun Spots ON / OFF
* Filled Average Sun Spots ON / OFF

The bottom left "Block" controls whether RECORD MARKERS are turned on or off.    Record markers are 
displayed on the screen and on the printouts, and denote where the high and low sun spot and solar flux 
dates occurred.    When one or more of the options is turned on, a small triangle will be displayed at the 
bottom of the pertinent frame, with a bold line running up to the top of the frame to denote a record date.

The bottom right block contains two check boxes.    One that determine whether the grid is displayed 



behind the data in the frames, and another that determines whether "Cumulative Averaging" is on or not.   
The grid's resolution can be set through the Grid Resolution option menu selection.    By default, it is set to
months in the overall frame and weeks in the closeup frame, for both the display and printout.

The Check Boxes on the dialog are either checked (filled with an "X") or unchecked.    When the box is 
checked, that data type will be displayed or printed in the designated frame.    When the check box is 
unchecked, that particular data type will not be displayed.



CUMULATIVE AVERAGES DISPLAY ON / OFF

Using the method by which the averages are calculated in this program, there is a section at each end of 
the display that is not truly averaged properly.    This program uses a Moving Window of days for the 
averaging interval.    By this, I mean that each days average value is based on the current day, a certain 
number of days BEFORE the current day, and a certain number of days AFTER the current day.    Using 
the program defaults of a 28-day averaging period, with 13 lag days,    each day will be the average of the 
current day, 13 days before, and 14 days after.

Obviously, using this method, the first 13 days in the file (or whatever you have changed the Lag Days 
value to) don't have enough days BEFORE them to calculate the average properly.    Likewise, the last 14 
days in the file have the same problem.    Many people prefer to not have ANYTHING displayed during 
these two periods.    Others prefer to have SOMETHING displayed.    Therefore, a switch called 
CUMULATIVE AVERAGING may be turned on or off.    If it is ON, the two periods in the file where a 
proper average cant be calculated are displayed using a simple Cumulative Average calculation (the total 
of the values, divided by the number of values).    If you WANT to see this information, turn Cumulative 
Averages on.    The data will be displayed in a different color to distinguish it from the normal averages.    If
you don't want to see the cumulative averages, turn this switch Off.



FILLED PLOT OPTIONS

These option selections activates a dialog that allows you to set options that control whether "Filled Plots"
are on or off.    Filled plots create a more realistic view of the data, and make seeing certain trends in the 
data easier, however they display slightly slower. Here's how they work:

The normal plot method is a Skeleton plot, where the plot is just a series of line segments joined together. 
When you use a Filled plot, instead of a skeleton, the plot is actually Filled or shaded.    The drawback is 
that you will not see all of the data because some of it will be overlaid by the data in front of it.

If you look at one of the data plots, you will notice that normally the Solar Flux plot has the highest values. 
Following, in order of their amplitude, are the Average Solar Flux, Sun Spots, and Average Sun Spots.    
The Average Sun Spot plot normally has the lowest overall amplitude.

A Filled plot plots the values in Layers in the same order as noted above.    Since the Solar Flux has the 
highest amplitude, it is plotted first.    Next comes the Average Solar Flux, followed by the Sun Spots and 
Average Sun Spots.    The result is a series of colored layers, one on top of the other with the Solar Flux 
at the back, and the Average Sun Spots at the front.    The effect is very nice looking, and you can 
certainly see trends in the data quicker.



POSITION DATA DISPLAY ON / OFF

When this option is ON, as you move the mouse cursor around in a frame (either the overall or close-up 
frame), the date, sun spot value, solar flux value, and the value at the mouse cursor pointer is displayed.   
If you don't want to see this information displayed, turn this option off.

When Position Data is ON, a checkmark will be displayed beside the option on the menu.    When it is 
OFF, there will not be a checkmark displayed.



CLOSE-UP DAY SETTING

This option determines how many days are displayed on the close-up display (the lower of the two).    By 
default, this value is set to 252 days.    The higher this value, the more days you can see, but the closer 
together each will be.    The lower the value, the fewer days you can see, but each will be further apart.    
Select however many days you want.    This option is strictly a personal preference, and you    can change
it as desired.



LAG DAYS SETTING

This option lets you set the number of days lag in the averaging interval.    By default, this value    is set to 
13.    For further information on how the number of lag days is used, refer to the section on Averaging 
Calculations.



AVERAGING INTERVAL SETTING

This option lets you set the number of days in the averaging interval.    By default, this value    is set to 28, 
which closely corresponds to the Suns rotational cycle of 27.5 days.    For further information on how the 
averaging interval is used, refer to the section on Averaging Calculations.



COLOR OPTIONS

Selecting this option will bring up a sidebar menu listing the items that you can set the color for.    They 
are:

The BACKGROUND color used for each frame
The color of the GRID
The color of the SUN SPOT plot
The color of the SOLAR FLUX plot
The color of the AVERAGE SUN SPOT plot
The color of the AVERAGE SOLAR FLUX plot

Selecting any of these options with the mouse cursor (or pressing the key corresponding to the underlined
character) will display the Windows Colors dialog.

You can select the desired color from this dialog using the mouse (put the cursor on the desired color and
click the left button) or by using the [TAB] key to move through the color selections.    When the desired 
color is selected, click [OK] or press [ENTER].    The dialog will be cleared, and your display will be 
redrawn using the desired colors.

NOTE: In reality, Windows uses 16 colors for drawing most elements.    If you look closely at the color 
dialog, you will notice that some of the colors shown look like they have a Checkerboard pattern 
to them.    These colors are Dithered colors, and are generated by setting one pixel to one color, 
and adjoining pixels to another color (the Orange color for example,. Is generated by dithering red
and yellow pixels).    You eyes perceive the composite color as a different color.    When drawing 
lines that are only one pixel wide, it is all but impossible to dither the line, so Windows uses the 
closest match to the desired color.    The result is that come colors you select may not look correct
on the lines.    If you turn on Filled Plots on the Display Options dialog the colors used to fill the 
plot in will match the one you selected, but the border of the plot may not.    You may have to play 
with the colors a bit to get a set that you like.



BACKGROUND COLOR

This is the color of the background of the frames, behind the plots.    Make this some color that will give a 
lot of contrast between the other elements.



GRID COLOR

This is the color of the vertical grid denoting weeks, months or years (depending on how you configure 
the software).    This looks best when it is somewhat dim so that it doesn't grab your eye.    Gray or 
something like that works well.



SOLAR FLUX COLOR

This is the color in which the solar flux data is plotted.    If FILLED DATA is on, it is also the color used for 
the background of the plot.



SUN SPOT COLOR

This is the color in which the sun spot data is plotted.    If FILLED DATA is on, it is also the color used for 
the background of the plot.



AVERAGE SUN SPOT COLOR

This is the color in which the average sun spot data is plotted.    If FILLED DATA is on, it is also the color 
used for the background of the plot.



AVERAGE SOLAR FLUX COLOR

This is the color in which the average solar flux data is plotted.    If FILLED DATA is on, it is also the color 
used for the background of the plot.



EDIT MENU SELECTION

The Edit menu starts a utility that allows you to edit data from the data file.    All entries are displayed in a 
List Box showing the date, sun spot value, and solar flux value.
To EDIT or change a specific entry, scroll down the list box to the desired entry, using the Scroll Bar on 
the right side, then Double Click the entry.    This will bring up a small dialog that will let you change any of
the three values associated with the entry.    Once you have changed the desired values, click OK to 
return to the EDIT list box.    The data in the list box will be replaced with the newly-revised values, and 
when you exit the edit list box, the displays will be redrawn with the new data.

You can also ADD new entries to the data by clicking the ADD button at the bottom of the display.    When 
you do, a dialog will be displayed allowing you to enter a new DATA, SUN SPOT VALUE, and SOLAR 
FLUX VALUE.    When they are correctly entered, click OK to add the new entry to the data.    As above, 
when you click Done on the Edit dialog, the displays will be redrawn with the new entries added.

You can also INSERT or DELETE records from the data file.    Click the record in the list box just BEFORE
where you want to insert or delete records, and then click the [INS] or [DEL] button.    Either option will 
display a dialog box asking you how many records to insert or delete (by default, this value is 1).    Enter 
the desired value, and click OK to continue, or just click [CANCEL] to cancel the mode.    Note that either 
mode causes entries to be inserted or deleted AFTER the currently selected entry.    If you try to INSERT 
more entries than the list box will allow (see the note below), an error message will be displayed stating 
that the list box would not hold the entire file, and the INSERT option will be canceled.

NOTE:    There are a couple of things to be aware of before you use this editing section.    First, comment 
lines you may have in your data file ARE NOT PRESERVED.    If you have comments in the data file, 



when you Save the data, they will be LOST!    Next, if you have a large data file, you may not be able to 
load all of the entries into the editors list box.    Windows has a limitation on the amount of data that may 
be placed in a list box, and it is about 3500 lines the way this program structures the data.    If you exceed 
the limit nothing will be lost, but you will not be able to see the remaining entries.    See Errors - Listbox 
Would Not Hold Entire File for more information.



DOUBLE CLICK

To Double Click an item, position the mouse cursor on the desired item, and click the left mouse button 
TWICE in quick succession.



HELP MENU COMMANDS

The Help menu offers the following commands, which provide you assistance with this application: 

Help Displays this HELP file
About Displays the version number of this application.



OPEN COMMAND (FILE MENU)

Use this command to open an existing data file.

If you have changed the current data, you will be asked if you want to save the data first.    If you click Yes,
the data that is in memory will be written back into the file that you have open.    The current contents of 
the file will be overwritten, so be sure you want to save the data before you click Yes.

Once the data has been saved (if it has been changed), the FILE OPEN dialog will be displayed.    You 
can type in the name of the file if you want to, or use the scroll bars to select the desired file and directory.
Once the desired file has been selected, click OK to open the file.    The current screen data will be 
replaced with the data in the file that you selected.

Shortcuts
Keys: CTRL+O



FILE OPEN DIALOG BOX

The following options allow you to specify which file to open:
File Name

Type or select the filename you want to open.    This box lists files with the extension you select in the 
List Files of Type box. 

List Files of Type
Select the type of file you want to open:
*.DAT for DATA FILE such as GRAPH.DAT
*.* to display ALL files in the selected directory

Drives
Select the drive in which SOL201W stores the file that you want to open. 

Directories
Select the directory in which SOL201W stores the file that you want to open.



SAVE    COMMAND (FILE MENU)

Use this command to save the active data to its current name and directory.    If you want to change the 
name and directory of an existing document before you save it, choose the Save As command.

Shortcuts
Keys: CTRL+S



SAVE AS COMMAND (FILE MENU)

Use this command to save and name the active document.    SOL201W displays the Save As dialog box 
so you can name your document.    

To save a document with its existing name and directory, use the Save command.



FILE SAVE AS DIALOG BOX

The following options allow you to specify the name and location of the file you are about to save:
File Name

Type a new filename to save a document with a different name.    A filename can contain up to eight 
characters and an extension of up to three characters.    SOL201W adds the extension you specify in 
the Save File As Type box.

Drives
Select the drive in which you want to store the document.

Directories
Select the directory in which you want to store the document.



EXIT COMMAND (FILE MENU)

Use this command to end your SOL201W session.    You can also use the Close command on the 
application Control menu.    SOL201W prompts you to save documents with unsaved changes.

Shortcuts
Mouse: Double-click the application's Control menu button.

Keys: ALT+F4



ABOUT COMMAND (HELP MENU)

Use this command to display the copyright notice and version number of your copy of SOL201W, as well 
as the amount of free memory and system resources.



TITLE BAR

The title bar is located along the top of a window.    It contains the name of the application and the 
currently open data file.

To move the window, drag the title bar.    Note: You can also move dialog boxes by dragging their title 
bars.

A title bar may contain the following elements:
Application Control-menu button
Document Control-menu button
Maximize button
Minimize button
Name of the application
Name of the data file
Restore button



SCROLL BARS

Scroll Bars are used frequently in Windows software.    They may be either horizontal or vertical, but either
way they operate in the same manner.    Below is a figure showing the important parts of a scroll bar.

The SCROLL ARROWS may be used to "Scroll" the display left or right (with a horizontal scrollbar) or up 
and down (with a vertical scrollbar).    Just click on the arrow's "Box" to "Scroll" the display.

The PAGING AREA is used to scroll in increments greater than the "Single Line" scroll you get by clicking 
on the Scroll Arrows.    Clicking in either of these areas causes the display to scroll in a "Page" increment. 
How much a "Page" is depends on where you are at the time!

The THUMB BUTTON is used for two things.    It gives a relative visual indication of where your current 
position is within the data, and it is also used to SET the position in the data.    Place the mouse's cursor 
on the Thumb Button, press the left mouse button and hold it down.    Now, "Drag" the mouse to the 
desired position (left or right on a horizontal scroll bar, or up or down on a vertical scroll bar), and let the 
mouse button go.    The data will then be scrolled so that it is positioned relative to the new Thumb 
Button's position.



SIZE COMMAND (SYSTEM MENU)

Use this command to display a four-headed arrow so you can size the active window with the arrow keys.

After the pointer changes to the four-headed arrow:
1. Press one of the DIRECTION keys (left, right, up, or down arrow key) to move the pointer to the 

border you want to move.    
2. Press a DIRECTION key to move the border.
3. Press ENTER when the window is the size you want.

Note:    This command is unavailable if you maximize the window.

Shortcut
Mouse: Drag the size bars at the corners or edges of the window.



MOVE COMMAND (CONTROL MENU)

Use this command to display a four-headed arrow so you can move the active window or dialog box with 
the arrow keys.

Note:    This command is unavailable if you maximize the window.

Shortcut
Keys: CTRL+F7



MINIMIZE COMMAND (APPLICATION CONTROL MENU)

Use this command to reduce the SOL201W window to an icon.

Shortcut

Mouse: Click the minimize icon  on the title bar.
Keys: ALT+F9



MAXIMIZE COMMAND (SYSTEM MENU)

Use this command to enlarge the active window to fill the available space.

Shortcut

Mouse: Click the maximize icon  on the title bar; or double-click the title bar.
Keys: CTRL+F10 enlarges a document window.



CLOSE COMMAND (CONTROL MENU)

Use this command to close the active window or dialog box.

Double-clicking a Control-menu box is the same as choosing the Close command.

Shortcuts
Keys: Ctrl+F4 closes a document window



RESTORE COMMAND (CONTROL MENU)

Use this command to return the active window to its size and position before you chose the Maximize or 
Minimize command.



SWITCH TO COMMAND (APPLICATION CONTROL MENU)

Use this command to display a list of all open applications.    Use this "Task List" to switch to or close an 
application on the list.

Shortcut
Keys: CTRL+ESC

Dialog Box Options
When you choose the Switch To command, you will be presented with a dialog box with the following 
options:
Task List

Select the application you want to switch to or close.
Switch To

Makes the selected application active.
End Task

Closes the selected application.
Cancel

Closes the Task List box.
Cascade

Arranges open applications so they overlap and you can see each title bar.    This option does not 
affect applications reduced to icons.

Tile
Arranges open applications into windows that don't overlap.    This option does not affect applications 
reduced to icons.

Arrange Icons
Arranges the icons of all minimized applications across the bottom of the screen.



No Help Available

No help is available for this area of the window.



No Help Available

No help is available for this message box.




